Thesis/Dissertation Formatting FAQs

What are the Library deadlines for thesis and dissertation binding?

Spring Graduation - April 12  
Summer Graduation - July 12  
Fall Graduation - November 26

*If any of the posted deadlines fall on a weekend or holiday, then the thesis or dissertation is due to the Library on the following workday by 5:00 p.m.*

*These dates are for the submission of theses and dissertations to the Library for binding, the final step in meeting the thesis and dissertation degree requirements.*

Which formatting style should I use?

Consult your Thesis Advisor or Dissertation Chair to determine the correct/popular style manual for your specific discipline (ASA, MLA, APA, Turabian, or Chicago). Regardless of the discipline-specific style manual you use, be aware that some formatting specified in the UWG Formatting Handbook takes precedence over those in the style manual.

When should I schedule my defense?

Students should defend with their committee early enough in the semester to ensure they have sufficient time to complete all steps associated with the defense, modifications required by their defense committee, format review, format corrections, and submission of final copies to the Library for binding.

What should I take with me to my defense?

Consult your Thesis Advisor or Dissertation Chair for department and degree requirements, but it is recommended by the Format Reviewer that students take a copy of their paper, printed on regular copy paper, multiple copies of their format-approved Signature Page printed on the specified paper, and one copy each of the Binding Order Form and Format Review Form.

Having the format of the Signature Page pre-approved and present at the defense allows students to quickly and easily acquire the signatures of the committee members at the conclusion of their successful defense. Students may submit an electronic version of this page
to the Format Review for this purpose. If the defense is not scheduled before the first format review meeting, the formatting will still be reviewed, but the final format review will only take place after a successful defense and subsequent revisions have been completed, if any are recommended by the committee.

When does the Format Review need to be completed?
There is not a specific deadline set for the Format Review. However, keep in mind that the Format Review process is only finalized after a successful defense, the completion of any necessary revisions, and before materials are submitted to the Library for binding. The Format Reviewer must receive confirmation from the Thesis Advisor or Dissertation Chair of a successful defense before the final format review and payment for binding can be made to the UWG Cashier.

Also, be aware that other students will be working toward the same goal. It is beneficial to allow adequate time for last-minute revisions or the completion of any other task that may have been previously overlooked.

What does the Format Review involve?
The Format Review consists of:
- checking the order of the pages,
- proper page number placement (if any),
- margin maintenance and settings,
- consistent spacing and formatting throughout the document,
- spell-checking the information on the title page,

How does the Format Review process work?

It is recommended that students schedule a preliminary Format Review before the defense of their paper. This is particularly important for the approval of the Signature Page formatting. Once the formatting of this page has been approved, students may print the desired number of copies on the specified paper and, upon the successful defense, ask the committee members to sign it.

After the successful defense and revisions, if any, have been completed, a final Format Review session is required. This session is necessary to finalize the Format Review, ensuring the
document is ready for binding, and to complete the Format Review Form and Binding Order Form. Ideally, the final Format Review session should be scheduled a week before the Library’s binding deadlines.

Why is a preliminary review necessary?

A preliminary review aids the student in refining the formatting and, in some cases, correct problem areas before the submission of their document to the defense committee. It also ensures correct formatting of the Signature Page in preparation for gathering signatures at the conclusion of a successful defense.

What should I bring with me to the Final Format Review?

Once the student has the thesis or dissertation ready for the Final Format Review an appointment is made with the Format Reviewer.

Bring:
- Hard copy (printed) of document on regular copy paper
- Signed Signature Page on specified paper (format previously approved)
- Completed & Signed Format Review Form and Binding Order Form

The two forms, the Format Review Form and the Binding Order Form, are located at the end of the UWG Thesis and Dissertation Formatting Handbook. Both forms must be signed by the student and thesis/dissertation advisor prior to submitting them, and the final documents, to the Format Reviewer. The student and faculty advisor signatures indicate that editing and formatting have been completed by the student and reviewed by the advisor prior to submitting the document to the Format Reviewer for the Final Format Review. A check on the Format Review Form indicates the successful completion of the student’s defense.

How long does the review process take?

As with many processes, it is different for each student. The length of time it takes to complete this process depends on how many edits are determined by the committee, how well the instructions in the UWG Formatting Handbook were followed, and how quickly revisions are made, if any are recommended. It is suggested to begin the process as early as possible to ensure the timely submission of the document for binding.
Can I just submit an electronic copy of my thesis/dissertation for format review?

Electronic pages may be submitted to the Format Reviewer for preliminary review. However, viewing pages electronically will not ensure proper formatting as there are sometimes viewing differences between versions of word processing programs. Final Format Reviews require a hard copy of the document. The document may be printed on regular copy paper for the purpose of the Final Format Review, with the exception of the signed Signature Pages.

Formatting:

Your text is centered, but it doesn’t look like it’s in the middle of the line?

Check the “First Line Indent” and the “Left Indent” to make sure they are lined up with the one inch left margin of the page. This could be making your text bounce off to the right a bit. It helps to use the document ruler to view your pages.

How do I get all of the page numbers to line up on the right side of the page in the Table of Contents?

On your “Table of Contents” page, highlight the text on the entire page. While the text is highlighted, open the “Paragraph” dialog under the “Home” heading (top of the Word screen) by clicking on the arrow in the bottom right corner. Once the “Paragraph” dialog window is open, click on “Tabs” in the bottom left corner. Set the tab stop position to 6” while leaving the Alignment selection on “Left,” change the “Leader” selection to “2…. Click on “OK” to set the tab and the leader for the page. If you’ve already used multiple periods, spaces, or tabs, replace them with a single tab. This will align your page numbers on the right side of the page.

What’s the difference between a Page Break and a Section break?

Page breaks move you, in your paper, to the next page. A Continuous Break, previously called a Section Break, is necessary to separate the pages (or sections) to create new sections for numbering, creating different headers and footers, and different margins within a single document.

To create a new section of the document, enter a “Section break” or “Continuous break” at the end of the first page. Do this by putting the cursor at the bottom of the page, after the last character, and enter a “section break” or “Continuous break” (Select the “Page Layout” tab, “Breaks,” then “Continuous” under “Section Breaks”).
Once a new section has been created, you may “un-link” the sections to create different margins, headers, footers, or page numbers. To do this, enter the “Continuous break” then double-click into the “Header.” This action opens the “Header & Footer Tools” menu at the top of Word. Tell Word to unlink the sections by clicking on “Link To Previous.” One click will disconnect the sections. Another click and they are connected again.

In the case of most theses/dissertations, Section 1 will include the first two pages with two-inch top margins without page numbers (not linked to the next section). While Section 2 also begins at the two-inch top margin, the Roman numeral page number “iii” is added to the bottom center of the page. Section 3 would be the very next page, second page of the Abstract (if any), linked to Section 2 for the page numbers, but begins at the one-inch top margin. Section 4, linked to the previous section but with a two-inch top margin, would contain the Dedication, Acknowledgements, and Table of Contents. The Introduction (main body/text of the paper) begins the fifth section (at the top two-inch margin), not linked to previous sections. The second page of the text begins, in this example, section 6 because the page numbering begins on page 2. These pages are numbered with Arabic numerals placed in the upper right-hand corner of the page (above the top one-inch margin, but inside the right margin) and have a one-inch top margin. The first page of a new Chapter begins a new section with continuous page numbering. The top margin drops to two-inch margin for the first page only, then returns, on the second page, to the top one-inch margin.

Page margins - How do I make the second page of a section, like the second page of a chapter, begin at the top one-inch margin when the first page begins two-inches from the top of the page?

Insert a “Continuous Break,” move your cursor to the second page, then select “Custom” under “Margins,” again on the “Page Layout” tab. At the bottom of the dialog screen, before clicking on “OK,” apply the new margins to “This section.” To change the margin for the next section, put the cursor at the top of the first page or the bottom of the last one, enter a continuous section break, and set the margins as described above.

Instructions for headers, footers and Page numbers

For page numbers to count accurately, the numbers will need to be linked. Not the pages, just the numbering. To do this across multiple sections with different margins, tell Word to continue counting from the previous section, when new sections are created, by formatting the page numbers of the new section. Open the page number formatting dialog window (“Header & Footer Tools/Design” tab, then “Page Number” “Format Page Number”), and click on “Continue from Previous Section.”
There are three pages of your thesis/dissertation that will not have a page number: the Title page, the Signature Page, and the first page of Chapter One. Every other page of your document will either have a bottom-center or top-right page number.

**Roman Numerals**

Roman numeral page numbers, appear at the bottom center of the page and begin with the first page of the Abstract as page "iii." To add these numbers, insert a "Continuous Break," then select the "Insert" tab followed by "Page number" from the "Header & Footer" section. After moving your cursor to "bottom of the page," select "Plain number 2" to place the page number in the correct position (bottom center of the page). Once the number had been added, it will need to be changed to a Roman numeral and kept from appearing on the first two pages by unlinking the sections. (Click on "Link To Previous" to unlink the sections.)

To change the number to a small Roman numeral, highlight the page number in the Footer and select "Format Page Numbers," Under the "Page Number" selection, in the dialog window, change "Number Format" to the lower-case Roman numeral selection. Before exiting the window, at the bottom, change the “Start at” to “iii.” Check to see if the page numbers were applied to the first two pages. You may need to go back and delete the page numbers, if any were applied.

**Arabic Numbering**

For the body of the text, the counting begins over at “one,” but is not displayed. The page number does not appear on the very first page of text/body. The numbering begins on page two and continues until the last page of the document. The first page, beginning at the two-inch top margin, is a separate section. Create a new section for page two, by inserting a “Continuous Break.” Change the top margin to one inch and "Insert" “Page Number” by selecting “Top of Page” then “Plain Number 3.” Once the “Header & Footer Tools/Design” tab opens, click on “Link to Previous,” to separate the page from the previous section, then the number will need to be formatted. Open the dialog box under “Page Number” “Format Page Numbers.” Change the “Number format” to Arabic numbers (“1, 2, 3”), then “Start at” page “2.”

How do I get the page number to appear in the correct place, in the right direction, on "landscape pages" embedded within the document?

Try using a Text Box to place the numbers in the correct position on the page. The text within the Text Box can be rotated ("Text Direction" under the "Text Box Tools", "Format", "Text" section) to suit your needs. "Landscape pages" are generally rotated one-quarter turn counter-clockwise. In these cases, the page numbers should appear in the bottom right-hand corner turned one-quarter turn clockwise. Once the paper is placed within the document, the
number is seen in the correct location. To align the page number with the others, it should be placed just inside the right margin, but above the bottom margin.

How do I insert a “landscape” page into a “portrait-oriented” document?
Using these three steps, you can change the orientation of the page(s) between the continuous section breaks.

Step 1: Insert a ‘continuous’ section break at the bottom of the page before the page you want to change
Step 2: Move your cursor to the bottom of the page you want to change and insert a second continuous section break
Step 3: Move your cursor back onto the page you want to change and, under “Page Layout” select “Orientation” and “Landscape”

What exactly is an “Appendix” used for?

The Appendix is used to “make available material that is relevant to the text but not suitable for inclusion in it” (Handbook, page 13). The Appendix may include documents that were instrumental in forming or supporting your hypothesis, but not directly referred to in the text. Tables, figures, and illustrations referred to in the text of the document should be included in the text, not in the Appendix.

This section is “preceded by a Title or separation sheet with the title, Appendix, Appendixes or Appendices, two inches below the top of the page. This sheet is assigned a page number” (Handbook, page 13).

Where should I put my tables?

Tables and/or figures referred to in the text should be incorporated into the main body of the document. They should fit within the established margins of the page and carry a unique number and title. References to the information in the table or figure should include the unique number/title, not simply “the following table” or the” figure on the following page,” etc.

Tables are numbered separately from figures. A list of Figures or tables should be inserted following the Table of Contents if more than five are included in the document. For example, if you have seven charts and ten tables, the charts should be numbered 1-7 each with a unique, descriptive, title, while the tables are numbered 1-10. Titles for tables and charts should follow the pattern: “Table 3: …” Titles for tables appear at the top of the table while titles for figures are placed underneath.

One-half inch of space should separate the table or figure from the text. Tables or figures not large enough for one page should appear at the top or the bottom of the page, not
in the middle. Some disciplines ask students to place each table or figure on a separate page, without text.

Please see pages 11-13 of the Formatting Handbook for more detailed instructions.

Can I have a single line of text at the bottom/top of my page?
The Widow/orphan control is located on the “Paragraph” tab (“line and page breaks” then click on “Widow/Orphan control”). This feature should be turned on for the creation of your paper. A green check mark in the box will instruct Word not to allow single lines of text at the top or bottoms of pages.

- Widow – a single line of text at the top of the page (left over from the paragraph on the previous page)
- Force a page break before the last line on the previous page for two lines at the top of the page
- Orphan – a single line of text, beginning a paragraph, with the remaining text on the next page
- Force a page break before the orphan. Shortens the text on the page, and moves the beginning of the paragraph to the next page.

Completed by Annette Pritchett 4/2014